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Disclaimer:  Nonostante sia stata messa la massima cura nel preparare questo documento, ci sono
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KiCad  è un prodotto integrato per il disegno di schemi elettrici e per la realzzazine dello
sbroglio del circuito stampato (PCB), open source (GPL).

Prima di iniziare, dovete avere una copia di KiCad installata. Questo tutorial assume che
KiCad è installato nella directory C:\Kicad (o in C:\Programmi\Kicad). Puoi scaricare una
copia del programma dal seguente link:
http://iut-tice.ujf-grenoble.fr/cao/
Le istruzioni per l'Installazione sono disponibili sul web nella sezione Info:Install 

1. Una volta installato lancia “KiCad.exe”.

2. Quella che vedi è la finestra principale del programma:



3. Crea un nuovo progetto dal menù: “File” -> “New”

4. Ora fai click sul pulsante “New Folder” ( o in alternativa click con il pulsante di
destra “Nuovo->Cartella”) ed assegna il nome “tute1” alla nuova cartella.

5. Apri la nuova cartella appena creata facendoci un doppio click sopra.

6. Inserisci il nome del progetto nel campo in basso “File name”. Che per questo
tutorial lo chiameremo come la cartella “tute1”.

7. Ora fai click su “Open”. Dovresti  vedere che il nome del progetto è diventato
“tute1”.



8. Ira fai click sul pulsante dell'editore di schemi (Schematic Editor)

9. Dovrebbe apparire un messaggio d'errore che ti informa che il file non esiste (the
file tute1.sch not found), conferma facendo click su “OK”.

Editore di schemi (Schematic Editor)
10.Ora sei nella finestra dello Schematic Editor “EESchema”. All'interno della quale si

disegnano gli schemi elettrici.

11. Ora dovresti salvare il progetto del circuito attraverso il menù: “File” -> “Save Whole
Schematic Project”.



12.Fai click sul pulsante “page settings” (impostazione pagina) nella barra degli
strumenti in alto.

13.Seleziona la dimensione della pagina “Page Size” come “A4” e inserisci nel campo
“Title” il nome “Tute 1”.  Conferma con “OK”.

Inserimento dei simboli dei componenti (Insert Component Symbols)
14.Nella finestra di EESchema, fai click sul pulsante “Add components” (aggiungi

componente) nella barra degli strumenti a destra oppura salta direttamente al
punto 16 premendo il tasto “A”.



15.Fai click in al centro del rettangolo rosso nella finestra di editing (editazione) per
inserire il tuo primo componente, oppure premi il tasto “A”. Nota: Puoi premere il
tasto “?” per avere una lista delle scorciatoie da tastiera.

16.Apparirà la finestra “Component selection” (Selezione del componente). Puoi
inserire direttamente il nome esatto del componente e premere invio oppure andare
al passo successivo.



17.Fai click su “List All” (lista tutto). Apparirà la finestra “Select Lib” (Seleziona la
libreria).

18.Fai doppio click sulla libreria “device”.

19.Apparirà la finestra “Select Component” (Seleziona il componente).

20.Scorri verso il basso la finestra e seleziona il componente con un doppio click sulla
“R”.  Quest chiuderà la finestra “Select Component” ed inserirà il componente “R”
nel tuo schema.

21.Posizione il componente nel punto desiderato facendoci sopra un click con  il
pulsante sinistro del mouse.



22.Per avere un ingrandimento (zoom) del componente puoi usare il pulsante
“Magnifier” (lente d'ingrandimento) oppure usare la rotellina del tuo mouse per la
funzione “pan & zoom ” (zoom e spostamento).

23.Ora posiziona il mouse sopra il componente e premi 'r' sulla tastiera. Vedrai come il
componente ruota.

24.Click con il pulsante di destra del mouse nel mezzo del componente e seleziona
“Edit Component” -> “Value”. Oppure non fare click: semplicemente posiziona il
mouse e premi il tasto “V” sulla tastiera.



25.Apparirà la finestra “Component value” (Valore del componente).

26.Sostituisci il valore preimpostato “R” con “1k”.

27.Click su “OK”.

28.Ora il valore dentro alla resistenza dovrebbe essere “1k” .

29.  Per inserire un'altra resistenza, fai click dove vuoi che la resistenza sia inserita,
premi il tasto “Ins” , questo ripeterà l'ultimo inserimento, in alternativa premi la
lettera “C” (copia) quando il mouse è sopra la resistenza inserita.

30.Selezionando nuovamente un componente (Punto 14), apparirà ancora la finestra
“Component selection:”.

31.La resistenza “R” che avevi precedentemente scelto appare ora nella “history list”
(storia delle selezioni).

32.Fai click su “R” nell'history list”.

33.Posiziona la resistenza nella pagina.

34.Ripeti ancora i passaggi dal punto 30 per posizionare la terza resistenza.



35.Fai ora click con il pulsante di destra sulla seconda resistenza e poi click su “Delete
Component” (Cancella componente). Così rimuoverai il componente dallo schema.

36.Click destro sul terzo resistore e seleziona “Move Component” (Muovi
componente). 

37.Riposiziona il componente dove vuoi con un click con il pulsante sinistro. 

38.Ripeti i passi dal 24 al 27 sostituendo il valore “R” con “100” sul terzo resistore

39.Ripeti i passi dal 14 al 20, selezionando questa volta la libreria “microcontrollers”
invece della libreria “device”, selezionando poi il componente “PIC12C508A” al
posto di  “R”.



40.Rimani con il mouse sopra il componente microcontrollore. Premi in sequenza 'y' e
'x' sulla tastiera. Nota come il componente viene riflesso nei suoi assi x e y . Premi
di nuovo 'y' e 'x' per tornare all'orientamento originale. 

41.Ripeti i passi dal 14 al 20, selezionando questa volta la libreria “device” e
succesivamente il componente “LED”.

42.Organizza i componenti sulla pagina come illustrato di seguito (NOTA del traduttore:
verificare che tutti i punti di giunzione di un componente ricadano sempre in un
punto della griglia. Altrimenti adeguare opportunamente la misura della griglia con il
pulsante destro del mouse accedendo al menù rapido “grid select”):

43.Qualche volta potrebbe succedere che il componente che vuoi inserire nello
schema non è nelle librerie. Nei passi successivi vedremo come aggiungere un
nuovo componente alla libreria.

Editor della libreria dei componenti (Component Lib rary Editor)
44.Click sul pulsante “go to library editor” (vai all'editore di libreria) nella barra degli

strumenti in alto.



45.Avrai così aperto la finesta “Component Library Editor”.

46.Click sul pulsante “Select working library” (Seleziona la libreria di lavoro).



47.Nella finestra “Select Library” (Seleziona la libreria) fai click su “conn” e poi su “OK”.

48.Click su “New component” (nuovo componente).Nota del traduttore: nelle ultime
versioni il simbolo può essere leggermente diverso comunque è facilmente
individuabile e mantiene la posizione originale.



49.Apparirà ora la finestra “Component Properties “(proprietà del componente).

50.Assegna il nome “MYCONN3” al nuovo componente. Inserisci “J” nel campo
“Default reference designator” (Assegnatore di riferimento predefinito), e “1” nel
campo “Number of parts per package” (quantità di parti per blocco). 

51.Click su “OK”

52.Se appare il messaggio di notifica “has a convert drawing” fai click su “yes”.

53.Ora nel mezzo dello schermo apparirà iI nome del componente. Fai click qualche
volta su “magnifier +” per ingrandire un pò l'area.

54.Fai ora click sul pulsante “Add Pins” (aggiungi pin) nella barra degli strumenti.

55.Click sinistro sullo schermo immediatamente sotto all'etichetta “MYCONN3”.

56.Nella finestra “Pin Properties” (proprietà dei pin) che appare, inserisci come nome
del pin “VCC”, inserisci “1” come numero del pin, e seleziona come “Electrical type”



“Power output” poi fai click su “OK”.

57.Posiziona il pin facendo click dove vorresti che appaia, in basso a sinistra sotto
l'etichetta “MYCONN3”. Nota de ltraduttore: se non è apparso il quadrato come
visibile nell'immagine, successiva, sarà possibile crearlo come descritto al punto 61.

58.Ripeti i passi dal 55 al 57. Questa volta, “Pin name” deve essere “INPUT”, “Pin
number” deve essere “2”, e “Electrical Type” deve essere “Power input”.

59.Ripeti i passi dal 55 al 57. Questa volta “Pin name” deve essere “GND”, “Pin
number” deve essere “3”, e “Electrical Type” deve essere “Power output”.

60.Disponi i pin come da figura:



61.Fai click sul pulsante “Add rectangle” (aggiungi rettangolo).

62.Adesso vogliamo disegnare un rettangolo connesso ai pin, così some visibile di
seguito.  Per fare questo, facciamo click e rilasciamo il pulsante destro del mouse
dove vogliamo che sia l'angolo alto sinistro del rettangolo. Poi muoviamo il nostro
mouse fino al punto dove vogliamo che sia l'angolo basso destro del rettangolo,
facendo nuovamente click con il pulsante sinistro del mouse.

63.Click sul pulsante “Update current component in current library” (Aggiorna il
componente corrente nella libreria corrente).

64.Click sul pulsante “Save current loaded library on disk (file update)” (Salva la libreria
correntemente caricata, su disco).



65.Click  su “Yes” a qualsiasi messaggio che potrebbe apparire durante l'esecuzione
delle precedenti operazioni ai punti 63 e 64.

66.Ora puoi chiudere la finestra “Component Library Editor”. Così facendo dovresti
essere tornato alla finestra di EESchema.

67.Ripeti tutti i passi dal 14 al 20, questa volta però scegli la libreria “conn” ed il
componente “MYCONN3”.

68.Apparirà il nuovo componente da poco creato. Disponi il componento vicino al
secondo resistore. Premi il tasto 'y' per ribaltare il componente sull'asse y. 

69.L'identificatore del componente “J?” apparirà sotto l'etichetta “MYCONN3”. Click
destro su “J?”  e poi click su “move field” (muovi campo). Potrebbe essere d'aiuto
l'utilizzo dello zoom, alcune volte, prima di fare l'operazione. Riposizioniamo “J?”
sotto i pin.

70.Ora facciamo click sul pulsante “Add powers” (aggiungi alimentazione) sulla barra
degli strumenti destra, in alternativa usa il tasto “P”



71.Click suk pin del resistore da 1k, oppure premi il tasto “P”.

72.Nella finestra “Component selection” click su “List All” (elenca tutto).

73.Scorri verso il basso e seleziona “VCC” nella finestra “Select Component”. Click su
OK.



74.Click sopra il pin del resistore da 1k per posizionare VCC.

75.Click sopra il pin VDD del microcontroller.

76.Nella finestra “Component Selection history” seleziona “VCC” e click per
posizionare VCC sopra pin VDD del microcontroller.

77.Ripeti di nuovo posizionando VCC sopra il pin VCC di “MYCONN3”.

78.Ripeti i passi da 70 a 72 ma questa volta seleziononando GND.

79.Posiziona GND sotto il pin GND di  “MYCONN3”.

80.Posiziona un'altro simbolo GND un pò più in basso alla destra del pin VSS del
microcontroller. Addesso il tuo schema dovrebbe apparire come il seguente:



Connessioni
81.Click sul pulsante “Place a wire” (Posiziona un filo/connessione) sulla barra degli

strumenti destra. **Fai attenzione a non selezionare l pulsante più in basso “Place a
bus” (posiziona un BUS) il quale è identico a “Place a wire” ma ha lo spessore della
linea maggiore**. Puoi anche saltare questo passaggio usando il tasto scorciatoia
“W”.



82.Ora fai click sul piccolo cerchio alla fine del pin 7 del microcontroller e subito dopo
sul piccolo cerchio del pin due del LED. In alternativa al click del mouse, puoi usare
il tasto “W” . Nota: qualche volta è necessario un doppio-click alla fine del filo nel
caso in cui W non riesca a terminare il filo. Quando il puntatore del mouse, al
click/W non è su un piccolo cerchio di connessione, allora viene creata una
deviazione (curva).   

83.Ripeti il processo di connessione con gli altri componenti come di seguito mostrato.
Per terminare un filo che non è connesso a niente fai un doppio click. Quando
colleghi I simboli VCC e GND, il filo deve toccare il punto basso del simbolo VCC e
il punto mediano alto del simbolo GND.



84.Assegniamo un nome alla rete facendo click sul pulsante “Place net name”
(Assegna un nome alla rete) nella barra degli strumenti destra (opzionale: alle reti
non nominate viene comunque assegnato un nome alfanumerico – se vuoi puoi
passare al punto 92).

85.Click nel mezzo del filo tra il microcontroller ed il LED.

86.Inserisci il nome “uCtoLED”.

87.Ora con un click vicino al piccolo cerchio alla destra del pin 7 posizioniamo il nome
della rete (N.D.T. il quadratino verde visibile deve posizionarsi sul filo).

88.Nominiamo il filo come “LEDtoR” e lo posizioniamo il filo tra il resistore ed il LED.

89.Nominiamo il filo come “INPUTtoR” e lo posizioniamo il filo tra “MYCONN3” ed il
resistore.

90.Nominiamo la linea come “INPUT” e la posizioniamo alla destra del resistore da 100
ohm.

91.Nominiamo la linea dal pin 6 come “INPUT”. Questo crea una connessione invisible
tra i due pin etichettati come “INPUT”. Questa tecnica è molto utile quando
colleghiamo i fili in circuiti molto complessi dove il disegno delle linee potrebbe
portare a una confusione del disegno stesso.

92.Non avete etichettato le linee VCC and GND perchè l'etichetta è implicita
nell'oggetto di alimentazione che avete connesso.



93.Il programma controlla per eventuali errori di connessione. Ogni punto o linea di
conessione non connessa può generare un messaggio d'avvertimento. Per evitare
questi messaggi, potete dire al programma che le linee non connesse sono volute. 

94.Fai click sul pulsante “Place no connect” (posiziona la non connessione).



95.Click su i piccoli cerchi alla fine delle linee 2, 3, 4 e 5.  una “X” apparirà  a
significare che la disconnessione è intenzionale.

96.Per aggiungere eventuali commenti allo schema usa il pulsante “Place graphic text
(comment)” (Posiziona testo grafico) nella barra degli strumenti destra.

Aver identificatori di componenti univoci 
97.Ora i singoli componenti necessitano di avere un unico identificatore. Per fare

questo fai click sul pulsante “Annotate schematic”.

98.Nella finestra “Annotate Schematic”, seleziona “Use the current page only” (usa
solo la pagina corrente) e poi fai click sul pulsante “Annotation” (annotazione).



99.Click “OK” al messaggio di conferma dopodiché click su “Close” nella finestra
“Annotate Schematic”.

100. Nota come ora tutti i “?” sui componenti sono stati sostituiti con un numero.
Ogni identificatore è unico. Nel nostro esempio “R1”, “R2”, “U1”, “D1” e “J1”.

101. Click ora sul pulsante “Schematic Electric Rules Check” (controllo delle
regole dello schema). Premi il pulsante “Test ERC” nella finestra che apparirà.

102. Questo genererà un rapporto per informarti su qualsiasi errore o
avvertimento come ad esempio connessioni non attive. Dovresti avere “0 Errors” e
“0 Warnings”. Una piccola freccia verde apparirà nella locazione dell'errore qualora
tu abbia sbagliato qualcosa. Controlla il “Write erc report” e premi il pulsante “Test
ERC” di nuovo per avere più informazioni riguardo all'eventuale errore.

Preparazione per il Layout (allocazione dei componenti e sbroglio)
103. Click su “Netlist generation” (generazione della netlist) nella barra degli

strumenti in alto.



104. Click su “Netlist” e poi su “save” o “Salva” accettando il nome file proposto.

105. Click su “Run Cvpcb” (avvia Cvpcb) nella barra degli strumenti.  

106. Click su OK se appare un errore relativo all'apertura del file o di un
componente della libreria.

107. Cvpcb ti permette di agganciare le impronte/moduli dei componenti alla lista.
Nel panello di sinistra, seleziona “D1”. Nel pannello di destra scorri in basso, trova
“LEDV” e facci doppio click sopra.

108. Per “J1” seleziona il modulo “3PIN_6mm”.

109. Per “R1” e “R2” seleziona il modulo “R1”.



110. Seleziona infine il modulo “DIP-8__300” per “U1”.

111. Ora fai click on “File”->”Save As”. Il nome predefinito “tute1.net” va bene,
termina facendo click su “save” o “salva”. 

112. Ritorna all'editor di schemi, salva il progetto facendo click su “File” -> “Save
Whole Schematic Project” (Salva l'intero progetto).

113. Ora passa alla finestra principale di KiCad.

114. Seleziona la voce di menù “Browse” -> “View File”.

115. Se appare un messaggio d'errore scegli il tuo visualizzatore di file testo. Molti
computers utilizzano il percorso “c:\windows\system32\notepad.exe”.

116. Seleziona il file “tute1.net”. Cosi aprirai il file con la tua netlist che descrive i
componenti e le connessioni fra i vari pin. 

117. Chiudi ora il tuo editor di testo e ritorna alla finestra di “EESchema.

118. Per creare la lista del materiale, fai click sul pulsante “Bill of materials”, nella
barra degli strumenti in alto.

119. Click su “OK” e poi su “Save” o “Salva”.

120. Per vedere il file creato ripeti i passi 113-115 selezionando però “tute1.lst”.

121. Chiudi l'editor di file testo.

Editore del Layout
122. Ora fai click sul pulsante “Run Pcbnew” (Avvia Pcbnew) nella barra in alto.



123. Si aprirà la finestra di “Pcbnew”.

124. Click su “OK” se ti appare un messaggio d'errore riguardo al file che non
esiste.

125. Click su “File” -> “Save”.

126. Click sul pulsante “Page settings” (impostazione pagina) nella barra degli
strumenti in alto.

127. Seleziona “paper size” (formato pagina) come “A4” ed inserisci “Tute 1” nel
campo del titolo “title”.

128. E' una buona idea impostare adesso la dimesione dell'isolamento tra
componenti o piste e l'impostazione dello spessore minimo per le tracce realizzabile
dal tuo produttore di PCB. Come esempio noi imposteremo l'isolamento (clearance)
a 0.015” e lo spessore minimo per la traccia a 0.01” (N.D.T. : tutte i valori numerici
sono espresse in pollici)

129. Click ora sul menù  “Design Rules” -> “Design Rules” (regole del progetto).
 

130. Se non è già visibile fai click sul tab “Net Classes Editor” (Editore delle classi
di rete).

131. Sostituisci il valore attuale del campo “Clearance”  in alto nella finestra con
“0.015” e il campo “Track Width” con “0.01”.

132. Fai click sul tab “Global Design Rules” end imposta “Min track width” (lo
spessore minimo della pista) a 0.01”.



133. Click sul pulsante OK per salvare I cambiamenti e chiudere la  finestra del
“Design Rules Editor”.

134. Click ora sul pulsante “Read Netlist” (leggi la  netlist) sulla barra in alto.

135. Click sul pulsante “Browse Netlist Files” (elenca i file di netslist), seleziona
“tute1.net” nella finestra di selezione del file, dopodichè fai su “Read Current Netlist”
(leggi la netlist corrente). Alla fine fai click sul pulsante “Close”.

136. I componenti saranno posizionati nell'angolo in alto a sinistra
immediatamente sopra la pagina. Scorri il foglio verso l'alto se non riesci a vederli.



Posizionamento dei moduli/impronte (Placing Footprints)
137. Click destro su di un componente, click sul nome del componente in alto al

menù, e poi fai click su “Move”. Sposta ora il componente in mezzo al foglio.

138. Ripeti il precedente passo fino a quando tutti i componenti non saranno
dentro la pagina.

139. Accertati che il pulsante “Hide board ratsnest” sia selezionato così potrai
vedere le connessioni collegate ai componenti mentre li trascini (Nota: il
suggerimento della barra è vecchio; premendo il pulsante si visualizzano le
connessioni).

140. Sposta i componenti cercando di minimizzare il numero di incroci tra le piste.



141. Se scompare la tracciatura tra componenti o lo schermo appare confuso, fai
click con il pulsante destro del mouse e seleziona  “Redraw view” (ridisegna la
vista).

Aggiungere le piste (Add tracks)
142. Ora collegheremo tutte le linee ad eccezione della linea di massa (GND)

sullo strato/faccia (layer) frontale.

143. Seleziona “Front” nel menù a discesa nella barra degli strumenti in alto.



144. Click pulsante “Add Tracks and vias” barra degli strumenti a destra.

145. Click nel mezzo del pin 1 di “J1” disegna la pista fino alla piazzola di “R2”.
Fai doppio click per definire il punto finale della pista.

146. Ripeti l'operazione collegando tutte le linee, eccetto il pin 3 of J1.

147. Ora seleziona “Back” nel menù a discesa nella barra degli strumenti in alto.

148. Click sul pulsante “Add tracks and vias”.

149. Disegna una pista tra il pin 3 di J1 ed il pin 8 di U1.

150. Click sul pulsante “Net highlight” (evidenzia la rete) nella barra di destra.



151. Click sul pin 3 di J1. Dovrebbe contornarsi di giallo.

Generazione dei piani ramati (Generate Copper Planes)
152. Click sul pulsante “Add Zones” (aggiungi zona) nella barra di destra.

153. Adesso andiamo a tracciare un rettangolo intorno al circuito, fai click dove
vuoi che sia uno degli angoli. Nella finestra che appare imposta “Pad connection:” a
“Thermal relief” e “Outline slope:” a “H,V, and 45 deg only”, confermando con “OK”.

154. Traccia intorno a quello che vuoi sia il bordo dell'area ramata facendo click
ad ogni angolo. Per terminare chiudi il rettangolo con un doppio click nel punto di
partenza.

155. Click destro all'interno dell'area appena tracciata.

156. Click su “Fill or Refill All Zones” (riempi tutte le zone). Ora il circuito dovrebbe
essere stato riempito con il verde.

157. Il tuo circuito dovrebbe esse molto simile al seguente:

158. Ora seleziona “PCB Edges” (bordi del circuito) nel menù a discesa nella
barra degli strumenti in alto.



159. Seleziona il pulsante “Add graphic line or polygon” (aggiungi una linea grafica
o poligono) nella barra degli strumenti destra.

160. Disegna quello che vuoi sia il bordo della scheda facendo click ad ogni
angolo,  ricordandoti di lasciare un a breve distanza tra il bordo del verde ed il
bordo della scheda.

161. Avvia il controllo delle regole progettuali (DRC) facendo click su “Perform
Design Rules Check”.

162. Click su “Start DRC”. Non dovrebbero esserci errori.

163. Click su “List Unconnected”. La lista dovrebbe essere vuota.

164. Click su “OK” per chiudere la finestra del controllo DRC.

165. Salva il tuo disegno con un click sul menù “File” -> “Save”.

166. Per ammirare la tua scheda in 3D,  fai click sul menù “3D Display” -> “3D
Display” (N.D.T. Oppure sul menù  “View ->3D Display”).

167. Puoi ruotare la scheda a 360° facendo click e t rascinando il mouse.



168. La tua scheda è completa. Per inviare i dati al tuo produttore devi generare il
file GERBER.

Post produzione (Postprocessing)
169. Click sul menù “File” -> “Plot”.

170. Seleziona “Gerber” come “Plot Format” e fai click sul pulsante “Plot”. Click su
“Quit” per chiudere la finestra.

171. Per vedere il tuo file GERBER vai alla finestra principale di KiCad.

172. Click sul pulsante “GerbView”.

173. Dal menù a discesa nella barra degli strumenti in alto seleziona “Layer 1”.

174. Click sul menù “File” -> “Load Gerber file”.



175. Seleziona il file chiamato “tute1-Front.gtl” e poi fai click su “open”.

176. Ripeti i passi dal 173 al 175, questa volta selezionando “Layer 2” prima
caricando “tute1-Back.gbl” poi.

177. Ripeti i passi dal 173 al 175, questa volta selezionando “Layer 3” prima
caricando “tute1-SilkS_Front.gbo” poi.

178. Ripeti i passi dal 173 through 175, questa volta selezionando “Layer 4” prima
e caricando “tute1-SilkS_Back.gbo” poi.

In questo modo puoi esaminare gli strati che saranno inviati alla produzione.

Editore delle impronte/moduli (Footprint Editor)
In KiCad è già presente una libreria ricca di moduli, comunque potrebbe succedere che
tu abbia bisogno di un modulo non presente nella libreria di KiCad. Di seguito ti
indichiamo I passi da fare per creare in KiCad una nuovo modulo per il PCB:

179. Vai alla finestra di PCBnew.



180. Click sul pulsante “Open Module Editor” (apri l'editore di moduli) nella barra
degli strumenti in alto.

 

181. Si aprirà il “Module Editor”.

182. Click su “select working library” (seleziona la libreia di lavoro)  nella barra
degli strumenti in alto.

183. Per esercizio seleziona la libreria “connect”.

184. Click sul pulsante “New Module” (nuovo modulo)  nella barra degli strumenti.

185. Digita “MYCONN3” come “module reference”.

186. Nel mezzo dello schermo apprirà l'etichetta “MYCONN3”.

187. Sotto l'etichetta sarà presente il testo “VAL**”.

188. Click destro su “MYCONN3” e poi  click sopra “VAL**”.

189. Click destro su “VAL**”, seleziona “Edit Text Mod” e sostituisci il valore con
“SMD”. 

190. Spunta il valore del campo “Display” a “Invisible”.

191. Seleziona ora “Add Pads” (aggiungi piazzola) dalla barra di destra. 

192. Click sullo schermo per posizionare la piazzola.



193. Click destro sulla nuova piazzola e poi click su “Edit Pad”.

194. Imposta I valori di “Pad Num” a “1”, “Pad Shape” a “Rect”, “Pad Type” a
“SMD”, “Shape Size X” a “0.4”, e “Shape Size Y” a “0.8”. Click su “OK”.

195. Click ancora su “Add Pads” per posizionare 2 ulteriori piazzole.

196. Sposta le etichette “MYCONN3” e “SMD” fuori dalle piazzole. Dovresti avere
qualcosa di simile alla figura.

197. Click sul pulsante “Add graphic line or polygon” sulla barra degi strumenti
destra.

198. Disegna il contorno del connettore intorno al componente. 



199. Click su “Save Module in working directory” nella barra degli strumenti in alto,
lasciando il nome predefinito MYCONN3.

200. Adesso puoi ritornare nella finestra di PCBnew e fare click sul pulsante “Add
modules” nella barra degli strumenti di destra.

201. Click sullo schermo , si aprirà  finestra “Place module“.

202. Scrivi  “MYCONN3” e posiziona il modulo nella tua scheda.

Quello che abbiamo fatto è una breve esercitazione sulle principali caratteristiche di
KiCad. Per ulteriori dettagli esiste un dettagliato documento di aiuto accessibile da tutti i
moduli di KiCad facendo click sul menù “Help -> Contents”.


